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ADOBE PREMIERE PRO CS5 CLASSROOM IN A BOOK 1

Adobe® Premiere® Pro CS5, the essential editing tool for video enthusiasts and 

professionals, enhances your creative power and freedom. Adobe Premiere Pro 

is the most scalable, efficient, and precise video-editing tool available. Whether 

you’re working with DV, HD, HDV, AVCHD, P2 DVCPRO HD, XDCAM, 

AVC-Intra, or RED, the superior performance of Adobe Premiere Pro lets you 

work faster and more creatively. The complete set of powerful and exclusive 

tools lets you overcome any editorial, production, and workflow challenges to 

deliver the high-quality work you demand.

About Classroom in a Book

Adobe Premiere Pro CS5 Classroom in a Book® is part of the official training 

series for Adobe graphics and publishing software. The lessons are designed 

so that you can learn at your own pace. If you’re new to Adobe Premiere Pro, 

you’ll learn the fundamental concepts and features you’ll need to use the 

program. This book also teaches many advanced features, including tips and 

techniques for using the latest version of this software.

The lessons in this edition include opportunities to use features such as the 

new Ultra keyer, improved editing efficiency, tapeless media, and the ability 

to send a sequence to Adobe® Encore® CS5 without rendering or intermediate 

exporting to be output to DVD, Blu-ray Disc, or Adobe® Flash® Professional 

CS5. Performance has been significantly enhanced with the new Mercury 

Playback Engine, which provides both software- and hardware-assisted 

performance breakthroughs. Adobe Premiere Pro CS5 is available for both 

Windows and Mac OS.

GETTING STARTED



2 Getting Started

Prerequisites

Before beginning to use Adobe Premiere Pro CS5 Classroom in a Book, make sure 

your system is set up correctly and that you’ve installed the required software and 

hardware. You should have a working knowledge of your computer and operat-

ing system. You should know how to use the mouse and standard menus and 

commands and also how to open, save, and close files. If you need to review these 

techniques, see the printed or online documentation included with your Windows 

or Mac OS system.

Installing Adobe Premiere Pro CS5

You must purchase the Adobe Premiere Pro CS5 software separately from this 

book. For system requirements and complete instructions on installing the soft-

ware, see the document Adobe Premiere Pro ReadMe.html on the software DVD.

Install Adobe Premiere Pro from the Adobe Premiere Pro CS5 software DVD onto 

your hard disk; you cannot run the program from the DVD. If you purchased the 

download version of Adobe Premiere Pro, follow the instructions included with the 

download for launching the installation process. Follow the on-screen instructions. 

The installation process also installs Adobe® Encore® CS5, Adobe® OnLocation™ 

CS5, Adobe® Bridge CS5, and some shared components.

Make sure your serial number is accessible before installing the application; you 

can find the serial number on the registration card, on the back of the DVD case, 

or in your user account online if you purchased the download version.

Adobe Premiere Pro CS5 trial

Adobe offers a 30-day trial of Adobe Premiere Pro CS5. You can download this trial 

from the Adobe product website. After 30 days, the software will stop functioning. 

If you decide to purchase Adobe Premiere Pro, you can enter your purchased serial 

number into the trial version you have installed to convert it to a full version of 

Adobe Premiere Pro CS5.

 Note: The Adobe Premiere Pro CS5 trial is fully functioning and is a great way for you to try the 
features. However, a few features are disabled in the trial version.

Specifically, the trial version of Adobe Premiere Pro CS5 does not include some features that 
depend on software licensed from parties other than Adobe. For example, some codecs for 
encoding MPEG formats are available only with the full version of Adobe Premiere Pro.
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Optimizing performance

Editing video is memory- and processor-intensive work for a desktop computer. 

A fast processor and a lot of memory will make your editing experience much faster 

and more efficient; 2 GB of memory is the minimum, and 8 GB or more is better for 

high-definition (HD) media. Adobe Premiere Pro CS5 takes advantage of multicore 

processors on Windows and Macintosh systems and will run on Macintosh com-

puters with multicore Intel processors.

A dedicated 7200 RPM or faster hard drive is recommended for standard-definition 

(SD) or high-definition video (HDV) media. A RAID 0 striped disk array or SCSI 

disk subsystem is recommended for HD. Performance will be significantly affected 

if you attempt to store media files and program files on the same hard drive.

The Mercury Playback Engine in Adobe Premiere Pro can operate in software-only 

mode or GPU acceleration mode. The GPU acceleration mode provides significant 

performance improvement. The GPU acceleration is possible with select video 

cards. You can find a list of these video cards on the Adobe website at http://www.

adobe.com/go/premiere_systemreqs.

Copying the lesson files

The lessons in Adobe Premiere Pro CS5 Classroom in a Book use specific source files, 

such as image files created in Adobe® Photoshop® CS5 and Adobe® Illustrator® CS5, 

audio files, and videos. To complete the lessons in this book, you must copy all the 

files from the Adobe Premiere Pro CS5 Classroom in a Book DVD (inside the back 

cover of this book) to your hard drive. You will need about 3.5 GB of storage space 

in addition to the 12 GB you need to install Adobe Premiere Pro CS5.

Although each lesson stands alone, some lessons use files from other lessons, so you’ll 

need to keep the entire collection of lesson assets on your hard drive as you work 

through the book. Here’s how to copy those assets from the DVD to your hard drive:

1 Open the Adobe Premiere Pro CS5 Classroom in a Book DVD in My Computer 

or Windows Explorer (Windows) or in the Finder (Mac OS).

2 Right-click (Windows) or Control-click (Mac OS; if you’re using a super mouse 

or pen, you can right-click) the folder called Lessons, and choose Copy.

3 Navigate to the location you set to store your Adobe Premiere Pro CS5 projects.

The default location is My Documents\Adobe\Premiere Pro\5.0 (Windows) or 

Documents/Adobe/Premiere Pro/5.0 (Mac OS).

4 Right-click (Windows) or Control-click (Mac OS) the 5.0 folder, and choose Paste.

Following these steps will copy all the lesson assets to your local folder. This process 

may take a few minutes to complete, depending on the speed of your hardware.

 Tip: A common disk 
configuration is to put 
the operating system 
and applications on 
drive 1, video and audio 
files on drive 2, and 
export files on drive 3.
For HD work, drive 2 
should be a RAID 0
striped disk array or 
SCSI disk subsystem.

http://www.adobe.com/go/premiere_systemreqs
http://www.adobe.com/go/premiere_systemreqs


4 Getting Started

How to use these lessons

Each lesson in this book provides step-by-step instructions for creating one or 

more specific elements of a real-world project. The lessons stand alone, but most of 

them build on previous lessons in terms of concepts and skills. So, the best way to 

learn from this book is to proceed through the lessons in sequential order.

The organization of the lessons is workflow-oriented rather than feature-oriented, 

and the book uses a real-world approach. The lessons follow the typical sequential 

steps video editors use to complete a project, starting with acquiring video, laying 

down a cuts-only video, adding effects, sweetening the audio track, and ultimately 

exporting the project to DVD, Blu-ray Disc, or Flash.

Additional resources

Adobe Premiere Pro CS5 Classroom in a Book is not meant to replace documenta-

tion that comes with the program or to be a comprehensive reference for every 

feature. Only the commands and options used in the lessons are explained in this 

book. For comprehensive information about program features and tutorials, refer 

to these resources:

Adobe Community Help: Community Help brings together active Adobe product 

users, Adobe product team members, authors, and experts to give you the most 

useful, relevant, and up-to-date information about Adobe products. Whether 

you’re looking for a code sample or an answer to a problem, have a question about 

the software, or want to share a useful tip or recipe, you’ll benefit from Community 

Help. Search results will show you not only content from Adobe, but also from the 

community.

With Adobe Community Help you can:

Access up-to-date definitive reference content online and offline

Find the most relevant content contributed by experts from the Adobe 

community, on and off Adobe.com

Comment on, rate, and contribute to content in the Adobe community

Download Help content directly to your desktop for offline use

Find related content with dynamic search and navigation tools

To access Community Help: If you have any Adobe CS5 product, then you already 

have the Community Help application. To invoke Help, choose Help > Premiere 

Pro help. This companion application lets you search and browse Adobe and com-

munity content, plus you can comment on and rate any article just like you would 

in the browser. However, you can also download Adobe Help and language refer-

ence content for use offline. You can also subscribe to new content updates (which 

 Note: You can 
control many aspects 
of Adobe Premiere 
Pro CS5 using multiple 
techniques, such as 
menu commands, 
context menus, and 
keyboard shortcuts. 
Sometimes more than 
one of the methods are 
described in any given 
procedure so that you 
can learn different ways 
of working, even when 
the task is one you’ve 
done before.
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can be automatically downloaded) so that you’ll always have the most up-to-date 

content for your Adobe product at all times. You can download the application 

from www.adobe.com/support/chc/index.html

Adobe content is updated based on community feedback and contributions. You 

can contribute in several ways: add comments to content or forums, including links 

to web content; publish your own content using Community Publishing; or contrib-

ute Cookbook Recipes. Find out how to contribute: www.adobe.com/community/

publishing/download.html

See http://community.adobe.com/help/profile/faq.html for answers to frequently 

asked questions about Community Help.

Adobe Premiere Pro CS5 Help and Support: www.adobe.com/support/premiere

where you can find and browse Help and Support content on adobe.com.

Adobe TV: http://tv.adobe.com is an online video resource for expert instruction 

and inspiration about Adobe products, including a How To channel to get you 

started with your product.

Adobe Design Center: www.adobe.com/designcenter offers thoughtful articles 

on design and design issues, a gallery showcasing the work of top-notch designers, 

tutorials, and more.

Adobe Developer Connection: www.adobe.com/devnet is your source for techni-

cal articles, code samples, and how-to videos that cover Adobe developer products 

and technologies.

Resources for educators: www.adobe.com/education includes three free curricu-

lums that use an integrated approach to teaching Adobe software and can be used 

to prepare for the Adobe Certified Associate exams.

Also check out these useful links:

Adobe Forums: http://forums.adobe.com lets you tap into peer-to-peer discus-

sions, questions and answers on Adobe products.

Adobe Marketplace & Exchange: www.adobe.com/cfusion/exchange is a central 

resource for finding tools, services, extensions, code samples and more to supple-

ment and extend your Adobe products.

Adobe Premiere Pro CS5 product home page: www.adobe.com/products/

premiere

Adobe Labs: http://labs.adobe.com gives you access to early builds of cutting-edge 

technology, as well as forums where you can interact with both the Adobe devel-

opment teams building that technology and other like-minded members of the 

community.

www.adobe.com/support/chc/index.html
www.adobe.com/community/publishing/download.html
www.adobe.com/community/publishing/download.html
http://tv.adobe.com
www.adobe.com/support/premiere
www.adobe.com/designcenter
www.adobe.com/devnet
www.adobe.com/education
www.adobe.com/cfusion/exchange
www.adobe.com/products/premiere
www.adobe.com/products/premiere
http://labs.adobe.com
http://community.adobe.com/help/profile/faq.html
http://forums.adobe.com
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Adobe certification

The Adobe training and certification programs are designed to help Adobe custom-

ers improve and promote their product-proficiency skills. There are four levels of 

certification:

Adobe Certified Associate (ACA)

Adobe Certified Expert (ACE)

Adobe Certified Instructor (ACI)

Adobe Authorized Training Center (AATC)

The Adobe Certified Associate (ACA) credential certifies that individuals have the 

entry-level skills to plan, design, build, and maintain effective communications 

using different forms of digital media.

The Adobe Certified Expert program is a way for expert users to upgrade their 

credentials. You can use Adobe certification as a catalyst for getting a raise, finding 

a job, or promoting your expertise.

If you are an ACE-level instructor, the Adobe Certified Instructor program 

takes your skills to the next level and gives you access to a wide range of 

Adobe resources.

Adobe Authorized Training Centers offer instructor-led courses and training 

on Adobe products, employing only Adobe Certified Instructors. A directory of 

AATCs is available at http://partners.adobe.com.

For information on the Adobe Certified programs, visit www.adobe.com/support/

certification/main.html.

Checking for updates

Adobe periodically provides updates to software. You can easily obtain these 

updates through Adobe Updater, as long as you have an active Internet connection.

1 In Premiere Pro, choose Help > Updates. Adobe Updater automatically checks 

for updates available for your Adobe software.

2 In the Adobe Updater dialog box, select the updates you want to install, and 

then click Download and Install Updates to install them.

 Note: To set 
your preferences for 
future updates, click 
Preferences. Select 
how often you want 
Adobe Updater to 
check for updates, for 
which applications, and 
whether to download 
them automatically. 
Click OK to accept the 
new settings.

www.adobe.com/support/certification/main.html
www.adobe.com/support/certification/main.html
http://partners.adobe.com
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Accelerate your workflow with 

Adobe CS Live

Adobe CS Live is a set of online services that harness the connectivity of the web and integrate with 
Adobe Creative Suite 5 to simplify the creative review process, speed up website compatibility testing, 
deliver important web user intelligence and more, allowing you to focus on creating your most impactful 
work. CS Live services are complimentary for a limited time* and can be accessed online or from within 
Creative Suite 5 applications.

Adobe BrowserLab is for web designers and developers who need to preview and test their web pages 
on multiple browsers and operating systems. Unlike other browser compatibility solutions, BrowserLab 

renders screenshots virtually on demand with multiple viewing and diagnostic tools, and can be used with 
Dreamweaver CS5 to preview local content and different states of interactive pages. Being an online service, 
BrowserLab has fast development cycles, with greater flexibility for expanded browser support and updated 
functionality.

Adobe CS Review is for creative professionals who want a new level of efficiency in the creative review 
process. Unlike other services that offer online review of creative content, only CS Review lets you publish 

a review to the web directly from within InDesign, Photoshop, Photoshop Extended, and  Illustrator and view 
reviewer comments back in the originating Creative Suite application.

Acrobat.com is for creative professionals who need to work with a cast of colleagues and clients in order 
to get a creative project from creative brief to final product. Acrobat.com is a set of online services that 

includes web conferencing, online file sharing and workspaces. Unlike collaborating via email and attend-
ing time-consuming in-person meetings, Acrobat.com brings people to your work instead of sending files to 
people, so you can get the business side of the creative process done faster, together, from any location.

Adobe Story is for creative professionals, producers, and writers working on or with scripts. Story is a 
collaborative script development tool that turns scripts into metadata that can be used with the Adobe 

CS5 Production Premium tools to streamline workflows and create video assets.

SiteCatalyst NetAverages is for web and mobile professionals who want to optimize their projects for 
wider audiences. NetAverages provides intelligence on how users are accessing the web, which helps 

reduce guesswork early in the creative process. You can access aggregate user data such as browser type, 
operating system, mobile device profile, screen resolution and more, which can be shown over time. The data is 
derived from visitor activity to participating Omniture SiteCatalyst customer sites. Unlike other web intelligence 
solutions, NetAverages innovatively displays data using Flash, creating an engaging experience that is robust 
yet easy to follow.

You can access CS Live three different ways:

1 Set up access when you register your Creative Suite 5 products and get complimentary access that includes 
all of the features and workflow benefits of using CS Live with CS5.

2 Set up access by signing up online and get complimentary access to CS Live services for a limited time. 
Note, this option does not give you access to the services from within your products.

3 Desktop product trials include a 30-day trial of CS Live services.

*CS Live services are complimentary for a limited time. See www.adobe.com/go/cslive for details.

www.adobe.com/go/cslive
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4 SHOOTING AND CAPTURING
GREAT VIDEO ASSETS

Topics covered in this lesson

Shooting great video

Capturing video clips

Capturing an entire videotape

Using batch capture and scene detection

Capturing analog video

Capturing HDV and other HD video

This lesson will take approximately 45 minutes.
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Your fi rst task is to shoot some great-looking video. 
Then you’ll use Adobe Premiere Pro CS5 to capture 
that video, meaning transfer it from your camcorder 
to your hard drive. Adobe Premiere Pro makes this 
process fast and easy.
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Getting started

The purpose of this book is to help you use Adobe Premiere Pro to make profes-

sional-looking videos. To do that, you need to start with high-quality raw material. 

This lesson gives you tips for shooting great video and then describes how to get 

that video into Adobe Premiere Pro.

Tips for shooting great video

With your camcorder of choice in hand, it’s time to venture out and shoot videos. 

If you’re new to videography, following these tips will help you create better 

videos. If you’re an old hand, think of this list of shooting axioms as a way to snap 

out of your routine and juice things up a bit:

Get a closing shot.

Get an establishing shot.

Shoot plenty of video.

Adhere to the rule of thirds.

Keep your shots steady.

Follow the action.

Use trucking shots.

Find unusual angles.

Lean forward or backward.

Get wide and tight shots.

Shoot matched action.

Get sequences.

Avoid fast pans and snap zooms.

Shoot cutaways.

Use lights.

Grab good sound bites.

Get plenty of natural sound.

Plan your shoot.
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Get a closing shot

Your closing images are what stick in people’s minds. You should be constantly on 

the lookout for that one shot or sequence that best wraps up your story.

Get an establishing shot

An establishing shot sets a scene in one image. Although super-wide shots work 

well (aerials in particular), consider other points of view: a shot from the cockpit 

of a race car, a close-up of a scalpel with light glinting off its surface, or a shot of 

paddles dipping frantically in roaring white water. Each grabs the viewer’s attention 

and helps tell your story.

The establishing shot sets the scene: It’s a wide shot of the 
villain in his medieval environment.

The close-up shot tells the story: The villain is speaking 
intensely to the hero.

Shoot plenty of video

Videotape is cheap and expendable, and with tapeless cameras that record to 

compact flash media and hard drives, storage space is usually ample and can always 

be reused. Shoot a lot more raw footage than you’ll put in your final production. 

Five times as much is not unusual. Giving yourself that latitude might help you grab 

shots you would have missed otherwise.

Adhere to the rule of thirds

It’s called the rule of thirds, but it’s more like the rule of four intersecting lines. 

When composing your shot, think of your viewfinder as being crisscrossed by two 

horizontal and two vertical lines. The center of interest should fall along those lines 

or near one of the four intersections, not the center of the image.

Consider all those family photos where the subject’s eyes are smack dab in the 

center of the photo. Those are not examples of good composition.
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Another way to follow the rule of thirds is to look around the viewfinder as you 

shoot, not just stare at its center. Check the edges to see whether you’re filling the 

frame with interesting images. Avoid large areas of blank space.

Keep your shots steady

You want to give viewers the sense they’re looking through a window or, better yet, 

are there with your subjects on location. A shaky camera shatters that illusion.

When possible, use a tripod. The best “sticks” have fluid heads that enable you to 

make smooth pans or tilts.

If it’s impractical to use a tripod, try to find some way to stabilize the shot: Lean 

against a wall, put your elbows on a table, or place the camcorder on a solid object.

Follow the action

This might seem obvious, but keep your viewfinder on the ball (or sprinter, speed-

ing police car, surfer, conveyor belt, and so on). Your viewers’ eyes will want to 

follow the action, so give them what they want.

One nifty trick is to use directed movement as a pan motivator. That is, follow a 

leaf ’s progress as it floats down a stream, and then continue your camera motion 

past the leaf—panning—and widen out to show something unexpected: a waterfall, 

a huge industrial complex, or a fisherman.

Use trucking shots

Trucking or dolly shots move with the action. For example, hold the camera at 

arm’s length right behind a toddler as she motors around the house, put the camera 

in a grocery cart as it winds through the aisles, or shoot out the window of a speed-

ing train.
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Find unusual angles

Getting your camcorder off your shoulder, away from eye level, leads to more inter-

esting and enjoyable shots. Ground-level shots are great for gamboling lambs or 

cavorting puppies. Shoot up from a low angle and down from a high angle. Shoot 

through objects or people while keeping the focus on your subject.

Lean forward or backward

The zoom lens can be a crutch. A better way to move in close or away from a sub-

ject is simply to lean in or out. For example, start by leaning way in with a tight shot 

of someone’s hands as he works on a wood carving; then, while still recording, lean 

way back (perhaps widening your zoom lens as well) to reveal that he is working in 

a sweatshop full of folks hunched over their handiwork.

Get wide and tight shots

Our eyes work like medium-angle lenses. So, we tend to shoot video that way. 

Instead, grab wide shots and tight shots of your subjects. If practical, get close to 

your subject to get the tight shot rather than use the zoom lens. Not only does it 

look better, but also the proximity leads to clearer audio.

Shoot matched action

Matched action keeps the story flowing smoothly while helping illustrate a point.

Consider a shot from behind a pitcher as he throws a fastball. He releases it, and 

then it smacks into the catcher’s glove. Instead of a single shot, grab two shots: a 

medium shot from behind the pitcher showing the pitch and the ball’s flight toward 

the catcher, and a tight shot of the catcher’s glove. It’s the same concept for an art-

ist: Get a wide shot of her applying a paint stroke to a canvas, and then move in for 

a close shot of the same action. You’ll edit them together to match the action.

Get sequences

Shooting repetitive action in a sequence is another way to tell a story, build inter-

est, or create suspense. A bowler wipes his hands on a rosin bag, dries them over 

a blower, wipes the ball with a towel, picks up the ball, fixes his gaze on the pins, 

steps forward, swings the ball back, releases it, slides to the foul line, watches the 

ball’s trajectory, and then reacts to the shot.

Instead of simply capturing all this in one long shot, piecing these actions together 

in a sequence of edits is much more compelling. You can easily combine wide and 

tight shots, trucking moves, and matched action to turn repetitive material into 

attention-grabbing sequences.
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Avoid fast pans and snap zooms

Fast pans and zooms fall into MTV and amateur video territory. Few circumstances 

call for such stomach-churning camera work. In general, it’s best to minimize all 

pans and zooms. As with a shaky camera, they remind viewers they’re watching TV.

If you do zoom or pan, do it for a purpose: to reveal something, to follow someone’s 

gaze from his or her eyes to the subject of interest, or to continue the flow of action 

(as in the floating leaf example). A slow zoom in, with only a minimal change to the 

focal length, can add drama to a sound bite. Again, do it sparingly.

Keep on rolling along

Don’t let this no-fast-moves admonition force you to stop rolling while you zoom 
or pan. If you see something that warrants a quick close-up shot or you need to pan 
suddenly to grab some possibly fleeting footage, keep rolling. You can always edit 
around that sudden movement later.

If you stop recording to make the pan or zoom or to adjust the focus, you might lose 
some or all of whatever it was you were trying so desperately to shoot. You will also 
miss any accompanying natural sound.

Shoot cutaways

Avoid jump cuts by shooting cutaways. A jump cut is an edit that creates a discon-

nect in the viewer’s mind. A cutaway—literally, a shot that cuts away from the 

current shot—fixes jump cuts.

Cutaways are common in interviews where you might want to edit together two 

10-second sound bites from the same person. Doing so would mean the intervie-

wee would look like he or she suddenly moved. To avoid that jump cut—that sud-

den disconcerting shift—you make a cutaway of the interview. That could be a wide 

shot, a hand shot, or a reverse-angle shot of the interviewer over the interviewee’s 

shoulder. You then edit in the cutaway over the juncture of the two sound bites to 

cover the jump cut.

The same holds true for a soccer game. It can be disconcerting to simply cut from 

one wide shot of players on the field to another. If you shoot some crowd reactions 

or the scoreboard, you can use those cutaways to cover up what would have been 

jump cuts.
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Use lights

Lights add brilliance, dazzle, and depth to otherwise bland and flat scenes. 

Consider using an onboard camcorder fill light and—if you have the time, 

money, patience, or personnel—a full lighting kit with a few colored gels.

In a pinch, do whatever you can to increase available light. Open curtains, turn 

on all the lights, or bring a couple of desk lamps into the room. Keep in mind one 

caveat: Low-light situations can be dramatic, and flipping on a few desk lamps can 

destroy that mood in a moment.

Grab good sound bites

Your narrator presents the facts. The people in your story present the emotions, 

feelings, and opinions. Don’t rely on interview sound bites to tell the who, what, 

where, when, and how. Let those bites explain the why.

In a corporate backgrounder, have the narrator say what a product does, and let the 

employees or customers say how enthusiastic they are about that product.

Your narrator should be the one to say, “It was opening night, and this was her first 

solo.” Let the singer, who is recalling this dramatic moment, say, “My throat was 

tight, and my stomach was tied in knots.”

In general, even though your interviews might take forever, use only short sound 

bites in your final production. Use those bites as punctuation marks, not paragraphs.

Exceptions for idiosyncratic 

characters

These admonitions are not carved in stone. Some characters you’ll videotape are 
so compelling, quirky, or humorous that your best bet is to let them be the primary 
narrator. Then you’ll want to consider what scenes you can use to illustrate their 
commentary. You don’t want to fill your entire video with a “talking head.”

Get plenty of natural sound

Think beyond images. Sound is tremendously important. Listen for sounds you can 

use in your project. Even if the video quality is mediocre, grab that audio.

Your camcorder’s onboard microphone is not much more than a fallback. Consider 

using additional microphones: shotgun mics to narrow the focus of your sound and 

avoid extraneous noise, lavalieres tucked out of sight for interviews, and wireless 

mics when your camera can’t be close enough to get just what you need.
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Plan your shoot

When you consider a video project, plan what you need to shoot to tell the story. 

Whether you’re videotaping your kid’s soccer championship match, a corporate 

backgrounder, or a medical procedure, you’ll need to plan your shoot to ensure 

success. Know what you want your final video project to say, and think of what 

you need to videotape to tell that story.

Even the best-laid plans and most carefully scripted projects might need some 

adjusting once you start recording in the field. No matter how you envision the 

finished project, be willing to make changes as the situation warrants.

Capturing video

Before you can edit your own video, you need to transfer it to your computer’s hard 

drive. In Lesson 3 you learned how to transfer video from tapeless media to Adobe 

Premiere Pro. Tapeless media has become the most common video format. But 

there are still plenty of video cameras around that record to tape. This section will 

cover how to capture video recorded onto tape to Adobe Premiere Pro CS5.

To bring footage into an Adobe Premiere Pro project, you can either capture it 

or digitize it, depending on the type of source material. The most common video 

formats recorded onto digital tape are DV and HDV.

You capture digital video from a live camera or from tape to the hard disk before 

using it in a project. Adobe Premiere Pro captures video through a digital port, 

such as a FireWire or Serial Digital Interface (SDI) port installed on the computer. 

Adobe Premiere Pro saves captured footage to disk as files and imports the files 

into projects as clips.

Alternatively, you can use Adobe OnLocation to capture video. You will take a 

closer look at OnLocation in Lesson 18.

You digitize analog video from a live analog camera source or from an analog 

tape device. You digitize the analog video and convert it to digital form so your 

computer can store and process it. The capture command digitizes video when a 

digitizing card or device is installed in the computer. Adobe Premiere Pro saves 

digitized footage to disk as files and imports the files into projects as clips.

In the analog world, the capture process takes several steps: transfer, convert, com-

press, and wrap. Your camcorder transfers the video and audio as analog data to a 

video capture card. That card’s built-in hardware converts the waveform signal to 

a digital form, compresses it using a codec (compression/decompression) process, 

and then typically wraps it in the AVI file format on Windows systems or in the 

QuickTime format for users working with Adobe Premiere Pro CS5 on the Mac.
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Three DV/HDV-capturing scenarios

Adobe Premiere Pro offers tools to take some of the manual labor out of the cap-

turing process. There are three basic approaches:

You can capture your entire videotape as one long clip.

You can log each clip’s In and Out points for automated batch capturing.

You can use the scene detection feature in Adobe Premiere Pro to automatically 

create separate clips whenever you press the Pause/Record button on your 

camcorder.

To do this exercise, you need a DV camcorder. Most DV camcorders have an IEEE 

1394 cable that you hook up to your computer’s IEEE 1394 connector. If your com-

puter does not have an IEEE 1394 connector, it is recommended that you buy an 

IEEE 1394 card.

You can work with HDV or with a professional-level camcorder with an SDI con-

nector and a specialized video capture card. Adobe Premiere Pro handles HDV and 

SDI capture with the same kind of software device controls used with a standard 

DV camcorder. SDI requires an extra setup procedure.

If you have an analog camcorder, you need a video capture card that supports 

S-Video or composite video connectors. The only option with most analog cam-

corders is to manually start and stop recording. Most analog capture cards do not 

work with remote device control or have timecode readout, so you can’t log tapes, 

do batch capture, or use the scene detection feature.

Capturing an entire DV tape

To capture an entire tape, follow these steps:

1 Connect the camcorder to your computer.

2 Turn on your camcorder, and set it to playback mode: VTR or VCR. Do not set 

it to camera mode.

Use AC, not a battery

When capturing video, power your camcorder from its AC adapter, not its battery. 
Here’s why: When using a battery, camcorders can go into sleep mode, and the bat-
tery will often run out before you’re done.

 Note: Different 
manufacturers have 
different brand names 
for their IEEE 1394 
cables. Apple calls 
this connector cable 
a FireWire cable while 
Sony calls it I.LINK.

 Note: Windows 
might note that 
you’ve powered 
up your camcorder 
by displaying a 
Digital Video Device 
connection message. 
Mac OS may start a 
default associated 
application, such as 
iMovie.
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3 In Windows, an AutoPlay dialog may pop up. Click “View more AutoPlay 

options in Control Panel.” Set the option to “Take no action.” (The next time you 

fire up your camcorder, you should not see this connection query.) In Mac OS, 

if iMovie or another application starts up, see that application’s Help for 

information about which application to open when a camera is connected.

4 Start Adobe Premiere Pro, click Open Project, navigate to the Lesson 04 folder, 

and double-click Lesson 04-01.prproj.

5 Choose File > Capture to open the Capture panel.
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6 Look above the Capture panel preview pane to make sure your camcorder is 

connected properly.

7 Insert a tape into your camcorder. Adobe Premiere Pro prompts you to give the 

tape a name.

8 Type a name for your tape in the text box. Be sure not to give two tapes the 

same name; Adobe Premiere Pro remembers clip in/out data based on tape 

names.

9 Use the VCR-style device controls in the Capture panel to play, fast-forward, 

rewind, pause, and stop your tape. If you’ve never used a computer to control 

a camcorder, this will seem pretty cool.

A B C I J KD E F G H

L M N QPO R S

A. Next Scene B. Set In Point C. Set Out Point D. Rewind E. Step Back F. Play
G. Step Forward H. Fast Forward I. Pause J. Stop K. Record L. Previous Scene
M. Go To In Point N. Go To Out Point O. Jog P. Shuttle Q. Slow Reverse
R. Slow Play S. Scene Detect

10 Try some of the other VCR-style buttons:

Shuttle (the slider toward the bottom) enables you to move slowly or zip 

quickly—depending on how far you move the slider off-center—forward 

or backward through your tape.

Single-frame Jog control (below the Shuttle slider)

Step Forward and Step Back, one frame at a time

Slow Reverse and Slow Play

11 Rewind the tape to its beginning or to wherever you want to start recording.

12 In the Setup area of the Logging tab, note that Audio and Video is the default 

setting. If you want to capture only audio or only video, change that setting.

 Note: If you get 
a No Device Control 
or Capture Device 
Offline message, you’ll 
need to do some 
troubleshooting. 
The most obvious fix 
is to make sure the 
camcorder is turned 
on and the cables are 
connected. For more 
troubleshooting tips, 
refer to the Adobe 
Community Help 
website.

 Note: To help you 
identify these buttons, 
move the pointer over 
them to see tool tips.

 Note: DV is the only 
format that allows you 
to select Audio only 
or Video only. When 
capturing HDV video, 
this drop-down box will 
be unavailable.



70 LESSON 4 Shooting and Capturing Great Video Assets

13 Click the Tape button in the Capture area of the Logging tab or the Record 

button in the Capture panel to start recording.

You’ll see (and hear) the video in the Capture panel and on your camcorder. 

Since there is a slight delay during capture, you’ll hear what sounds like an echo. 

Feel free to turn down the speaker on either your camcorder or your computer.

14 Click the red Record button or the black Stop button when you want to stop 

recording.

The Save Captured Clip dialog appears.

15 Give your clip a name (add descriptive information if you want), and click OK.

Adobe Premiere Pro stores all the clips you capture during this lesson in the 

Lesson 04 folder on your hard drive. You can change the default location by 

choosing Project > Project Settings > Scratch Disks.

Using batch capture and scene detection

When you perform a batch capture, you log the In and Out points of a number 

of clips and then have Adobe Premiere Pro automatically transfer them to your 

computer.

Use the logging process to critically view your raw footage. You want to look for 

“keeper” video, the best interview sound bites, and any natural sound that will 

enhance your production.

The purpose of using a batch capture is threefold: to better manage your media 

assets, to speed up the video capture process, and to save hard disk space (one hour 

of DV consumes roughly 13 GB). If you batch capture all your clips, you can use the 

combination of the Adobe Premiere Pro project file (which is relatively small) and 

the MiniDV tapes as a backup of your project. To reedit the project, simply open 

the project file and recapture the clips.

 Note: If you’re 
capturing HDV video, 
the video is not 
displayed in the Capture 
panel as it is being 
recorded.
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Use a clip-naming convention

Think through how you’re going to name your clips. You might end up with dozens 

of clips, and if you don’t give them descriptive names, it’ll slow down editing.

You might use a naming convention for sound bites such as Bite-1, Bite-2, and so 

forth. Adding a brief descriptive comment, such as “Bite-1 Laugh,” will help.

Here are the steps to follow:

1 In the Capture panel, click the Logging tab.

2 Change the Handles setting (at 

the bottom of the Logging tab) 

to 30 frames.

This adds one second to the start and 

finish of each captured clip, which will 

give you enough head and tail frames to add transitions without covering up 

important elements of the clip.

3 In the Clip Data area of the Logging tab, give your tape a unique name.

4 Log your tape by rewinding and then playing it.

5 When you see the start of a segment you want to transfer to your computer, 

stop the tape, rewind to that spot, and click the Set In button in the Timecode 

area of the Logging tab.

6 When you get to the end of that 

segment (you can use Fast Forward or 

simply Play to get there), click Set Out. 

The in/out times and the clip length 

will appear.

Three other ways to set 

In and Out points

You can use other means to set In points and Out points for selected clips: Click the 
brackets ({ or }) on the play controls, use the keyboard shortcuts (I for In and O for 
Out), or change the in/out time directly in the Timecode area by dragging left or 
right over the timecode.
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7 Click Log Clip to open the Log Clip dialog.

8 Change the clip name, if needed, 

and add appropriate notes if you 

want; then click OK.

That adds this clip’s name with 

its in/out times and tape name 

information to the Project panel 

(with “Offline” next to it). You’ll go 

there later to do the actual capture.

9 Log clips for the rest of your tape 

using the same method.

Each time you click Log Clip, 

Adobe Premiere Pro automatically 

adds a number to the end of your previous clip’s name. You can accept or 

override this automated naming feature.

10 When you’ve finished logging your 

clips, close the Capture panel.

All your logged clips will be in the 

Project panel, with the offline icon 

next to each.

11 In the Project panel, select all the 

clips you want to capture (see the 

following sidebar for three methods 

of doing that).

Three ways to select more 

than one item

There are usually three ways to select more than one file in a window. First, if the 
filenames are contiguous, click the top one, and then Shift-click the last one in the 
group. Second, you can click off to one side and above the top clip and then drag 
down to the last one to marquee-select a group. (The marquee-select method—
creating the gray rectangle—was used in the previous figure.) Finally, if the file-
names are scattered, click one first, and then Ctrl-click (Windows) or Command-click 
(Mac OS) each additional file in turn.
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12 Choose File > Batch Capture.

A very simple Batch Capture 

dialog opens, allowing you 

to override the camcorder 

settings or add more handle 

frames.

13 Leave the Batch Capture 

options unselected, and 

click OK.

The Capture panel opens, 

as does another little dialog 

telling you to insert the 

proper tape (in this case, it’s probably still in the camcorder).

14 Insert the tape, and click OK.

Adobe Premiere Pro now takes control of your camcorder, cues up the tape to 

the first clip, and transfers that clip and all other clips to your hard drive.

15 When the process is complete, take a look at your Project panel to see the 

results. The offline icon is now a movie icon, and your footage is ready to 

be edited.

Use scene detection

Instead of manually logging In and Out points, you might want to use the scene 

detection feature. Scene detection analyzes your tape’s time/date stamp, looking for 

breaks such as those caused when you press the camcorder’s Pause/Record button 

while recording.

When scene detection is on and you perform a capture, Adobe Premiere Pro 

automatically captures a separate file at each scene break it detects. Scene detection 

works whether you are capturing an entire tape or just a section between specific 

In and Out points.

To turn on scene detection, do either of the following:

Click the Scene Detect button (below the Record button in the Capture panel).

Select the Scene Detect option in the Capture area of the Logging tab.

 Note: Handles are 
extra frames at the 
beginning and end 
of a clip. For example, 
adding 30 frames as 
handles would add one 
second of video to the 
start and end of your 
clips. This can be useful 
for transitions.
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Then you can either set In and Out points and click Record or cue your tape to 

wherever you want to start capturing and click Record. In the latter case, click Stop 

when done.

Your clips will show up in the Project panel. You don’t need to batch capture 

them—Adobe Premiere Pro captures each clip on the fly. Adobe Premiere Pro then 

names the first captured clip by putting a “01” after the name you put in the Clip 

Name box and increments the number in each new clip name by one.

Tackling manual analog movie capture

If you need to transfer analog video—consumer-level VHS, SVHS, Hi-8, or pro-

fessional-grade video such as Beta SP—you need a video capture card with analog 

inputs. Most analog capture cards have consumer-quality composite connectors as 

well as S-Video and sometimes top-of-the-line component connections.

Check your card’s documentation for setup and compatibility issues.

With analog video, you have only one capture option: to do it manually.

1 Open the Capture panel (File > Capture).

2 Use the controls on the camcorder to move the videotape to a point several 

seconds before the frame you want to begin capturing.

3 Press the Play button on the camcorder, and then click the red Record button in 

the Capture panel.

4 When your clip has been captured, click the Stop button in the Capture panel 

and on the camcorder. Your clip will show up in the Project panel.

Capturing HDV and HD video

You can capture HDV video in the same way as DV video: by connecting the HDV 

camcorder or deck to your computer via IEEE 1394. When you start a new HDV 

project, select the appropriate HDV project preset, and capture as described for 

DV video.

HD video requires an SDI card in your computer to connect the coaxial interface 

from the HD camcorder to your computer. The vendor that supplies the SDI card 

will typically install additional HD presets into Adobe Premiere Pro as part of its 

installation.

 Note: HDV video 
is not displayed in the 
Capture panel while the 
video is being captured.
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Review questions

1 Why are cutaway shots so useful?

2 What should you check if you see “Capture Device Offline” at the top of the 

Capture panel?

3 What does scene detection do when selected?

4 What is one benefit of using batch capture rather than manual capture?

5 During the capture process, how do you add extra frames to ensure you have enough 

footage for transitions?

6 Is the actual media captured to your hard disk during a batch capture?

Review answers

1 Cutaway shots of a crowd, faces, or landscapes are often useful for covering up a bad 

shot or providing a pleasant transition to another scene.

2 Check that your camcorder or deck is connected to the computer and that it is turned 

on and in VCR mode.

3 Enabling scene detection causes clips to be automatically logged at each point where 

the camcorder was stopped or paused.

4 If you batch capture all your clips, it is possible to save your Adobe Premiere Pro 

project file (which is relatively small), store your DV tapes, and be able to recapture 

the project easily if you ever need to reedit. This is a very efficient means of backup.

5 Type a number of frames in the Handles option in the Capture area of the Logging tab.

6 Only information about the clip, such as the tape name and In and Out points, is 

captured when creating the batch list. The clip will be displayed as “Offline” in the 

Project panel. The media is captured when you go to the Project panel and perform 

the batch capture of offline files.
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NUMBERS

3D effect, using, 201
4-Color Gradient coloring effect, described, 293
5.1 digital audio, channels, 254
5.1 Mixdown setting, changing, 245
5.1 surround sound effects, using, 244–247, 

254–256
50 and 60 Hz hum

causes of, 256
removing in Soundbooth, 258

64-bit application, significance of, 10

SYMBOLS

* (asterisk), using to add marker, 307
\ (backslash) key

using to return to zoom level, 306
using to zoom Timeline, 214

: (colon), use with audio units, 222
, (comma) keyboard shortcut, using, 91
. (period) keyboard shortcut, using, 91
; (semicolon), use with video frame timecode, 222

A

AAF (Advanced Authoring Format) export 
option, using, 356

AATC (Adobe Authorized Training Center), 
explained, 6

A/B editing mode
managing head and tail handles, 109
using to fine-tune transitions, 106–109

AC adapter, using with camcorder, 67
ACA (Adobe Certified Associate), explained, 6
ACE (Adobe Certified Expert), explained, 6
ACI (Adobe Certified Instructor), explained, 6
Acrobat.com, features of, 7
action. See also motion

following, 62
following with Track Matte Key, 287–288
keyframing, 287

Action and Title Safe Areas settings, explained, 27
Ad Cliches Mono.wav mono track, playing, 235
Adobe After Effects CS5

animating lower third, 345–346
described, 14
exporting compositions from, 362
importing projects from, 347–348
mini-workflow, 15
options, 343
workspace, 343–344

Adobe Creative Suite 5 Production Premium, 
338–339

Adobe CS Live, accessing, 7
Adobe CS5 Production Premium

components of, 14–15
workflow, 15

Adobe Dynamic Link
described, 14
using to import projects, 347–348

Adobe Encore CS5
adding chapter markers to Timeline, 378
Blu-ray Disc format, 377
creating autoplay DVD, 379–381
creating menu DVD, 382–384
described, 14
Flash format, 377
getting Adobe Premiere Pro Timeline into, 

377
mini-workflow, 15
SD DVD format, 377

Adobe Flash Professional CS5, described, 14
Adobe Forums, consulting, 5
Adobe Illustrator files

editing in Illustrator, 34
treatment of, 34

Adobe Labs, consulting, 5
Adobe Media Encoder

choosing Format/Presets, 363
creating watch folders, 362
importing compositions from After Effects, 

362
launching, 266–267, 367
managing tasks, 363
overview of, 362–363
using, 362–363

Adobe OnLocation CS5. See also cameras
analyzing video, 328–330
changing Calibration workspace, 323
described, 14
mini-workflow, 15
recording features, 327
setting up, 322–324
synchronizing matching shots, 333
using to analyze color, 331
Waveform Monitor, 328–330

Adobe OnLocation clips, importing, 334
Adobe Photoshop files, importing as sequences, 

339–342
Adobe Premiere Pro CS5

as NLE (nonlinear editor), 11
obtaining trial version, 2
workspace layout, 17–19
workspace tour, 15–16

INDEX
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Adobe resources
Community Help, 4–5
Design Center, 5
Developer Connection, 5
for educators, 5
Forums, 5
Help and Support, 5
Labs, 5
Marketplace & Exchange, 5
product home page, 5

Adobe resources, consulting, 4–5
Adobe Story

features of, 7
script, 267

After Effects compositions, replacing 
clips with, 349–350

After Effects CS5
animating lower third, 345–346
described, 14
exporting compositions from, 362
importing projects from, 347–348
mini-workflow, 15
options, 343
workspace, 343–344

alpha-channel transparencies, using in 
compositing, 278–280

analog recorder, recording to, 357–358
analog video. See also video

digitizing, 66
transferring, 74

Analyze Content dialog
displaying, 265
Reference Script drop-down list, 

267
anchor points, changing for clips, 

193–194
anti-aliasing, defined, 34
aperture, adjusting for cameras, 325
Area Type tool, using with Titler, 124
assets

displaying information about, 33
displaying properties of, 34
finding, 41
finding with Media Browser, 42
importing, 32–33
managing via batch capture, 70
organizing in bin structure, 40

asterisk (*), using to add marker, 307
audio

adding J-cuts, 233–234
adding L-cuts, 235
adjusting in Effect Controls panel, 

229–230
analyzing with OnLocation, 331
changing zoom level for, 223
Constant Gain option, 230
dragging in Source Monitor, 88
floating-point data, 220
importing, 32–33
maintaining for speed changes to 

clips, 207
playing in Source Monitor, 222
samples per second, 220

audio and video, unlinking, 307
audio channels. See channels

audio clips
applying transitions to, 229–230
muting audio tracks for, 245

audio editing, 221–226
audio effects. See also mono effects; 

stereo effects
adding in Soundbooth, 260
Bass, 241
Delay parameters, 241
and editing, 12
MultibandCompressor, 246
PitchShifter, 242
Reverb, 242–243
sweetening sound with, 240–243
Treble, 242

Audio Effects Mono folder, opening, 
240

audio feedback, dealing with, 254
audio files, transcribing to text, 

264–266
Audio Gain tool, using, 231–232
Audio Mixer

adding effects to tracks, 249–250
adjusting Left/Right Pan, 249
automation modes, 251
features of, 18
Latch automation mode, 251
Mute settings, 250
Panner puck, 255
recording voice-overs, 253–254
Solo buttons, 250
Touch automation mode, 251
using to adjust volume levels, 

247–251
VU (volume unit) meter, 249

audio noise, cleaning up, 256–259
audio peak, setting, 232
Audio preferences, setting, 31
audio problem.wav, opening in Source 

Monitor, 256
audio samples, displaying in Source 

Monitor, 222
audio tracks

assigning to submix tracks, 220
clips in, 247
creating, 225
creating fade-in effect on, 228, 235
creating fade-out effect on, 228, 234
determining type of, 226
outputting to submixes, 251–253
types of, 220

audio transitions, adding, 111
audio volume, adjusting, 227–228, 

231–232. See also volume levels
audio-editing tools, availability of, 220
Auto Bezier interpolation, using with 

keyframes, 176–177
Auto Color effect, using, 297
Automate to Sequence process

following, 80–82
using with transitions, 110

autoplay DVD
creating, 379–381
described, 376 

autosaves, setting preferences for, 31

AVCHD media
importing, 54
performance of, 54
using CUDA graphics cards, 54
using in tapeless workflow, 48

B

backslash (\) key
using to return to zoom level, 306
using to zoom Timeline, 214

Bad TV 2 – old effect, locating, 350
Balance audio effect, using, 244
bars, adding for tapes, 356
Basic 3D effect, using, 180, 201
Bass audio effect, using, 241
batch capture

clip-naming convention, 71–72
logging tapes, 71
performing, 70–73
purposes of, 70

Batch list, defined, 312
batch-processing tasks, handling, 266
battery, using with camcorder, 67
Behind_The_Scenes_SD.avi clip, 

replacing, 349–350
Behind_the_scenes_SD.avi file, 

importing, 55
Beta SP video, transferring, 74
Bevel Edges Thin effect

adding to PIP effect, 198–199
using preset with, 198

Bezier interpolation, using with 
keyframes, 176

bins. See also folders
arranging in Icon view, 80
dragging clips between, 40–41
managing media in, 37–40
opening simultaneously, 40–41
using with Project panel, 18

black video, adding to tapes, 356
blend modes

combining layers based on, 
277–278

using with Photoshop layers, 341
blue-screen videos, using Ultra Key 

effect with, 282
Blu-ray Disc

creating, 385
pop-up menus, 385

border color, changing for transitions, 
105

Breakout To Mono option, using with 
channels, 224

Bridge CS5, described, 14
brightness

setting, 20, 31
setting in Waveform Monitor, 

328–330
Broadcast Colors coloring effect, 

described, 294
B-roll, defined, 233
brown matte clip, using Opacity effect 

with, 276
BrowserLab, features of, 7
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Brush Strokes coloring effect, 
described, 293

Bypass option, displaying in Timeline, 
229

C

cache files and locations, maintaining, 
31

Calibration workspace, changing in 
OnLocation, 323

camcorders. See also Adobe 
OnLocation CS5

kHz and bit-rate settings, 220
powering, 67
white balance controls on, 326

Camera Setup Assistant
setting focus, 325
setting iris/exposure, 325
setting up frames, 324
setting white balance, 326

Camera View effect, using, 201
cameras

adjusting aperture, 325
adjusting gain, 325
adjusting lighting, 325
adjusting shutter speed, 325
calibrating, 324–326
using multiple, 334

capture cards, support for, 13
Capture panel, opening for analog 

video, 74
capture parameters, setting, 31
Capture settings, explained, 27
capturing

DV tape, 67–70
HD video, 74
HDV video, 74
video, 66–67

Castle Room title, creating, 121, 123
cell phone sound, removing in 

Soundbooth, 258–259
certification, levels of, 6
Change to Color effect, using, 295
Channel Blur coloring effect, described, 

293
Channel Volume feature, using, 245. See 

also volume levels
channels

for 5.1 digital audio, 254
in 5.1 surround sound clip, 224–225
Breakout To Mono option, 224
creating links to, 224
editing individually, 224
hearing in 5.1 surround sound 

effects, 245
using Fill effects with, 245
viewing for stereo signals, 223

chapter markers, adding to Timeline, 
378

chroma keys
tips for, 283
using, 281

clip bounding box, activating in 
Program Monitor, 187–188

clip effect menu, using to edit 
keyframes, 246–247

clip handles, using with transitions, 
100. See also handles

clip size, changing, 191–194
clipboard, copying transcribed text 

to, 269
clips. See also Motion effects; speed of 

clips; subclips; video
adding rotation to, 193–194
adjusting audio volume for, 

227–230
adjusting in Trim panel, 92–93
applying Motion effects to, 186–190
applying transitions to, 110
assembling onto Timeline, 90–91
in audio tracks, 247
changing anchor points for, 

193–194
changing ending frame for, 94
changing speed of, 206–207
changing speed via keyframes, 

209–210
changing speed with Rate Stretch 

tool, 208
changing starting frame for, 94
choosing colors from, 105
compositing, 196–197
controlling speed of, 190
copying and pasting attributes of, 

277
copying collections of, 79
cutting “holes” in, 283–288
dragging between bins, 40–41
dragging from Source Monitor, 156
dragging to Timeline, 156
editing on Timeline, 82–86
fixing gaps between, 83–84
getting right length of, 208
importing, 331–333
making offline, 315
moving from Timeline, 86–89
moving to beginning of, 307
moving to end of, 307
moving to Timeline, 86–89
moving within Timeline, 86–89
nesting, 302–303
opening context menu for, 79
ordering in sequences, 81
placing in Source Monitor, 18
placing sequentially on Timeline, 81
replacing, 148
replacing with After Effects 

compositions, 349–350
reversing, 211–212
selecting, 93
selecting groups of, 308
setting In and Out points for, 71
slicing in two, 94
slowing down in Timeline, 206–207
speeding up in Timeline, 207
starting, 101
stretching and shrinking, 94
trimming, 82–85, 93–94
trimming in Source Monitor, 89

undoing speed changes for, 206
using Edit tool with, 84
using scene detection with, 73–74
in video tracks, 247
viewing in Source Monitor, 80

CMX 3600 switcher, described, 370
colon (:), use with audio units, 222
Color Balance (RGB) effect, using, 

296–297
color correction

effects, 293–294, 296
enhancements to, 13
purpose of, 292

color effects, technical, 294
color keys, using, 281
Color Picker, using with Titler, 136
color removal effects, described, 293
color replacement effects, described, 

293
color value, averaging for keying, 281
color wheel, parameters, 298
coloring effects, described, 293
color-oriented effects

Auto Color, 297
Change to Color, 295
Color Balance (RGB), 296–297
color correction, 296
Fast Color Corrector, 298–299
Leave Color, 294–295

colors
analyzing with Vectorscope, 330
choosing from clips, 105
selecting from videos, 136

color-stop color, changing in Titler, 136
comma (,) keyboard shortcut, using, 91
Command key. See keyboard shortcuts
Community Help, accessing, 4–5
Complete sequence, using with reverse 

motion, 212
compositing

color keying on green-screen, 
280–282

combining layers based on blend 
mode, 277–278

considering in shooting video, 275
creating split-screen effect, 286
incorporating into projects, 

274–275
methods, 274
using alpha-channel transparencies, 

278–280
using gradients in, 276–277
using matte keys, 283–288
using Opacity effect, 275–277
using Ultra Key effect, 281–282

Constant Gain option, using with audio, 
230

Constant Power transition
using, 111
using with J-cuts, 234

content analysis capabilities, availability 
of, 10

context menu, opening for clips, 79
Continuous Bezier interpolation, using 

with keyframes, 176–177
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Convert Anchor Point tool, using with 
text, 126

coordinate system, explained, 188
Copy command, keyboard shortcut 

for, 304
copying collections of clips, 79
crawling text, using in Titler, 132–133
credits, rolling, 132–133
Cross Dissolve effect

adjusting transition, 104–106
using between clips, 167
using with L-cut, 235

crossfade transition, adding to audio 
clip, 111

CS Review, features of, 7
CSV (comma-separated value) file, 

creating, 313
Ctrl key. See keyboard shortcuts
Cube Spin transition, creating, 302
CUDA graphics cards, using with 

AVCHD media, 54
current-time indicator

dragging through transitions, 109
moving to beginning of Timeline, 

101
scrubbing Timeline with, 87–88

cutaways, shooting, 64
cuts-only-sequence, audio added to, 82

D

dampening frequencies, 243
dark_loud.mov clip, playing, 329, 331
darkened rooms, editing in, 20
darkest setting, approaching, 20
dB (decibel) level readout

reducing in Soundbooth, 259
using with audio, 227

Default scale to frame size preference
explained, 31
setting for images, 36

Delay parameters, adding for audio, 241
deleting, text in Titler, 123, 125
Design Center, consulting, 5
design issues, consulting resource for, 5
Developer Connection, consulting, 5
developer products, consulting 

resource for, 5
Device Control preferences, setting, 31
digital still cameras, using for high-

definition video, 49
digital video (DV), capture scenarios, 

67
digital video workflow. See also editing 

workflow; workflows
advanced audio editing, 12
color correction, 13
hardware support, 13
keyframe controls, 13
Mercury Playback Engine, 13
multicam editing, 13
Project Manager, 13
steps for, 12

digitizing analog video, 66

directory, creating for lesson folders, 15
disk configuration, example of, 3
DLSR camera video support, availability 

of, 11
dolly shots, using, 62
drives, partitioning, 28
drop shadow, adding to PIP effect, 199
DV (digital video), capture scenarios, 67
DV tape, capturing, 67–70
DVD, using for AVCHD recording 

format, 48
DVD authoring, overview of, 376–377, 

379–381
DVD projects, exporting to Flash, 

385–386
DVDs, adding chapter markers to, 378
Dynamic Link

described, 14
using to import projects, 347–348

dynamic range, narrowing, 246
dynamically linked animations, editing, 

348

E

Ease In interpolation, using with 
keyframes, 176, 194

Ease Out interpolation, using with 
keyframes, 176

Edit Original option, using with 
Illustrator files, 34

edit point, establishing, 87–88
Edit tool, using with clips, 84
editing

four-point, 152
with In and Out points around 

clips, 152–153
with Snap feature, 84
with Track Lock feature, 150–151

editing tools
extract edits, 143
lift edits, 143
ripple edits, 142
rolling edits, 143–144
slide edits, 143, 145
slip edits, 143, 146
in Source Monitor, 90–91
timesaving, 142–147
in Tools panel, 93–94
using in Trim Monitor, 92

editing workflow, incorporating CS5 
components into, 13–14. See also
digital video workflow; workflows

Editing workspace, accessing, 33
edits, undoing in Program Monitor, 147
EDL (edit decision list) export option, 

using, 356, 370–371
educators, resources for, 5
Effect Controls panel

A/B feature, 106–108
adjusting audio in, 229–230
changing parameters in, 104–106
contents of, 166
expanding parameters for audio, 

241

features of, 19
Show/Hide Timeline View button, 

107
effects. See video effects
Effects panel

adding effects to, 260
choosing for transitions, 101
explained, 18

Effects workspace
switching to, 186
using with transitions, 100

encoding files. See Adobe Media 
Encoder

Encore. See Adobe Encore CS5
EQ (equalizer) effect, features of, 245
error messages

Low Memory Warning, 31
No Device Control or Capture 

Device Offline, 69
explosions, fading out, 234
Export Frame function, using, 358–359
export options

AAF (Advanced Authoring Format), 
356

EDL (edit decision list), 356
Final Cut Pro XML, 356
Media, 355
OMF (Open Media Format), 356
Tape, 355
Title, 355

Export Settings dialog
opening, 359
Source Settings drop-down list, 360
Source/Output tabs, 361
tabs in, 360

exporting
compositions from After Effects, 

362
DVD projects to Flash, 385–386
file formats, 364–365
to Final Cut Pro, 11
to mobile devices, 367–369
prioritizing, 10
titles, 120

exposure of cameras, determination 
of, 325

Extensible Metadata Platform (XMP), 
explained, 268

extract edits, explained, 143
Extract option, using with clips in 

Timeline, 87
eyedropper, using with Key Color chip, 

281

F

face matte, using, 287
faces, detecting in sequences, 270
fade-in effect

creating on audio tracks, 228
using with L-cuts, 235

fade-out effect
creating on audio tracks, 228
using with J-cuts, 234
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FAQs (frequently asked questions), 
consulting, 5

Fast Color Corrector effect, using, 
298–299

file formats, using, 364–367
file sizes, determining via Project 

Manager, 317
files

browsing with Media Browser, 42
importing from folders, 33
locating, 16, 34
selecting, 32
selecting in windows, 72

Fill Right audio effect, using, 245
fill text effects, using, 135–136
filters, using with video effects, 180
Final Cut Pro, exporting to, 11
Final Cut Pro XML export option, 

using, 356, 366–367, 369–370
Find tool, using with assets, 41
FireWire cable, using, 67
Flash, exporting DVD projects to, 

385–386
Flash Professional CS5, described, 14
Flash development, formats for, 366
flash memory, using for AVCHD 

recording format, 48
Flip Over transition, reversing, 102
floating panel, creating, 22
floating-point data, using with audio, 

220
FLV|F4V format, choosing, 366
focus, setting for cameras, 325
folders. See also bins

importing, 308
importing files from, 33
using with Project panel, 18

Font Browser, using in Titler, 118
footage, replacing, 149
Formant Preserve option, using with 

voice, 242
formats, using, 364–367
Forums, consulting, 5
frames

crowding, 21
exporting, 358–359
resizing, 20
setting up for cameras, 324
trimming with Snap feature, 84

frequencies
dampening, 243
managing, 246

frequently asked questions (FAQs), 
consulting, 5

FTP server, exporting video to, 360

G

gain adjustment
making for cameras, 325
mechanics of, 232

gaps between clips
avoiding, 85
finding in Timeline, 151–152

fixing, 83–84
removing, 100

Garbage Matte Key effect
using, 284–285
using to create split-screen effect, 

286
Gaussian Blur filter

using, 180
using with encoded output, 360

General tab, sections of, 27
GPU acceleration, benefits of, 164
gradients, using in compositing, 

276–277
graphic-file alpha channels, using, 

279–280
graphics

creating with square pixels, 37
importing, 32–33

grayscale, resolving jarring shifts to, 167
green-screen

color keying with Ultra Key, 
280–282

studios, 275

H

H.264 format, using, 366–367
Hand tool, described, 94
handles, defined, 73. See also clip 

handles
hard drive

recommendation for, 3
saving space, 70
using for AVCHD recording format, 

48
hardware, support for, 13
HDV (high-definition video)

automatic scene detection, 11
capture scenarios, 67
capturing, 69–70, 74
recording to tapeless format, 48
shooting with digital still cameras, 

49
system requirements, 3

headsets
using with microphones, 218
using with voice-overs, 219

Help and Support, accessing, 5
Help feature, opening, 307
Hero-analysis.mpg clip, loading into 

Source Monitor, 264
History panel

docking in frame, 21
features of, 19

Hold interpolation, using with 
keyframes, 176

Horizontal Center Distribute tool, 
using, 131

Hue Angle parameter, using in color 
wheel, 298

hum
causes of, 256
removing in Soundbooth, 258

I

IEEE 1394 cables, using, 67
I.LINK cable, using, 67
Illustrator CS5, described, 14
Illustrator files

editing in Illustrator, 34
treatment of, 34

images
creating with square pixels, 37
importing, 34–37
panning, 37
scaling automatically, 36
scaling manually, 36
zooming, 37

Import dialog, opening, 33
Import Script dialog, displaying, 267
importing

assets, 32–33
AVCHD media, 54
clips, 331–333
compositions from After Effects, 

362
folders, 308
images, 34–37
lower third.psd, 340
Medieval_villain_01.mpeg clip, 52
OnLocation clips, 334
P2 media, 53–54
Photoshop files as sequences, 

339–342
projects, 318
projects from After Effects, 

347–348
projects using Dynamic Link, 

347–348
and scaling media, 31
sequences, 318
XDCAM media, 50–52

In and Out Around Clip feature, using, 
152–153

In and Out Around Selection feature, 
using, 152–153

In and Out points, setting for clips, 71
In point

keyboard shortcut, 91
setting in Source Monitor, 88

Info panel
clicking, 33
features of, 19

Insert option, using with clips in 
Timeline, 86, 88

interface brightness, setting, 31
interpolation

adding to keyframes, 194–195
adding to video effects, 173–178
Ease In and Ease Out, 194
spatial, 194
temporal, 194

interviews, transcribing, 270
Iris Round transition, selecting, 105
iris/exposure, setting for cameras, 

325
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J

J-cuts, adding to audio, 233–234
JPEG clip, displaying in Program 

Monitor, 36
jump cuts, avoiding, 64

K

kerning, setting in Titler, 119
Key Color chip, using eyedropper with, 

281
keyboard shortcuts

adding audio transitions, 111
adding marker, 307
adding transitions, 101
availability of, 303–304
beginning of sequence, 307
changing, 304–305
Copy, 304
end of sequence, 307
file selection, 72
importing folders, 308
marquee-select, 308
moving clips per frames, 307
moving to beginning of clip, 307
moving to end of clip, 307
multifunction playback modifer 

key, 306
New Title dialog, 121
number of, 303
opening Help, 307
opening Import dialog, 33
opening Titler, 307
Out point, 91
In and Out points for clips, 71
playback controls, 306
playback modifier key, 306
In point, 91
Redo, 304
rendering Timeline, 55
resizing Timeline, 306
Rolling Edit tool, 144
Save, 304
selecting multiple files, 32
sending trimmed clips to Timeline, 

91
Slide tool, 145
toggling Snap feature, 307
tools, 306
undoing actions, 84, 304
undoing duration changes, 214
undoing edits in Program Monitor, 

147
undoing Replace Clip function, 149
undoing ripple delete, 150
undoing speed changes for clips, 

206, 213–214
unlinking audio and video, 307
work area bar’s end points, 307

“keyframable” options, using in Motion, 
191

keyframe adjustments, using Volume 
effect with, 228

keyframe controls, availability of, 13

keyframe editing, advantage of, 247
keyframe interpolation, applying in 

Timeline, 228
keyframes. See also speed keyframes

adding interpolation, 173–178, 
194–195

adding velocity, 173–178
adjusting on sequences, 94
changing Rotation value for, 175
changing time between, 190
changing values for, 172
creating for fade-in effects, 228
creating for fade-out effects, 228
editing using clip effect menu, 

246–247
relocating, 190
using Ease Out option with, 176
using to vary speed of clips, 

209–210
keyframing effects, adding, 169–172
keyframing motion, 287
keying, improving, 281
keying effects

Difference Matte Key, 286
Image Matte Key, 286
overview of, 280–281
Remove Matte Key, 286
using, 275
using in compositing, 274

L

Label Colors preferences, setting, 31
Labs, consulting, 5
layers, combining based on blend 

mode, 277–278
L-cuts, adding to audio, 235
leading, setting in Titler, 118
Leave Color effect, using, 294–295
Lens Flare filter, using, 180
lesson files

copying, 3
using, 4

lesson folders, creating directory for, 15
LFE (low-frequency effects), use of, 

254–255
lift edits, explained, 143
Lift option, using with clips in Timeline, 

87
light_quiet.mov clip, playing, 330–331
lighting effects, adding, 178–179. See 

also specular highlight
lights, using, 65
linear editing

managing head and tail handles, 
109

using to fine-tune transitions, 
106–109

linear interpolation, using with 
keyframes, 176

live video, recording, 326–327. See also
video

LL screen location, using with PIP 
effect, 196

logo.psd clip, adjusting position 
parameters, 278

Low Memory Warning alert, receiving, 
31

lower third
animating in After Effects, 345–346
example, 340

lower third.psd, importing, 340
lower-third animation, re-creating, 

341–342
LR screen location, using with PIP 

effect, 196
Luma Color coloring effect, described, 

294
luminance, representing, 328–330

M

Mac, export formats, 359
Mac keyboard shortcuts. See keyboard 

shortcuts
Make Offline option, using with 

trimmed projects, 317
marker, adding, 307
Marketplace & Exchange, consulting, 5
marquee-select method

using with files, 72
using with still images, 214

matte clip, using Opacity effect with, 
276

matte keys
garbage, 284
graphic, 284
using in compositing, 283–288

media
importing and scaling, 31
managing in bins, 37–40

Media Browser
expanding, 42
features of, 18
filtering assets in, 42
importing OnLocation clips with, 

334
using, 49
using to find assets, 42

Media Encoder
choosing Format/Presets, 363
creating watch folders, 362
importing compositions from After 

Effects, 362
launching, 266–267, 367
managing tasks, 363
overview of, 362–363
using, 362–363

Media export option, using, 355
media formats, mixing, 55–56
media types, importing, 32–33
medialink label colors, changing, 31
Medieval_Axe.mp3 file, selecting, 38
Medieval_dialog_hero.wav, using Audio 

Gain with, 231
Medieval_Hero_01.mpeg clip

editing, 88
loading into Source Monitor, 90
Speed/Duration example, 207
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Medieval_Hero_2 clip, nested 
sequence, 301

Medieval_JB02— stereo.aif, viewing in 
Source Monitor, 223

Medieval_villain_01.mpeg clip
adding video effect to, 166
importing, 52
opening, 52

Medieval.psd clip, using matte keys 
with, 284–285

memory
optimizing, 31
receiving Low Memory Warning 

alert, 31
recommendation for, 3

memory preferences, setting, 31
menu DVD

creating, 382–384
previewing, 384

Mercury Playback Engine
described, 10
GPU acceleration mode, 3
graphics card acceleration, 13
software-only mode, 3

Metadata panel
fields in, 265
Speech Transcript field, 265
using with speech analysis text, 269

Metalogging workspace, changing to, 
264

microphones
condenser, 218
dynamic, 218
positioning for voice recording, 219
using headsets with, 218

mobile devices, exporting to, 367–369
modifier keys. See keyboard shortcuts
modifier-key feedback, getting, 89
monitors, accessing, 18
mono effects, speaker icons used with, 

241. See also audio effects; stereo 
effects

Mono folder, opening in Audio Effects, 
240

mono track, Ad Cliches Mono.wav, 235
Mosaic effect, using, 288
motion. See also action

highlighting objects in, 288
highlighting people in, 288
keyframing, 287

Motion effects. See also clips; PIP 
(picture-in-picture) effect

activating in Effect Controls panel, 
187

Anchor Point option, 191
Anti-flicker Filter option, 191
applying to clips, 186–190
inputting degrees, 191
“keyframable” options, 191
percents in, 191
Position option, 191
Rotation option, 191
Scale option, 191–192
Scale Width option, 191
versus Transform effect, 200–202

Motion fixed effect, using, 174–178
Motion settings, examining, 187–190
Motion tool, using to scale images, 36
MPEG2 format, using, 366
MultibandCompressor effect, using, 

246
multicamera editing

“audio follows video” option, 160
availability of, 13
changing edits in Timeline, 160
finalizing, 160
syncing video, 160
tips for, 160

multicamera sequence
creating, 155–157
lining up markers in, 157
using markers with, 155

multiple cameras
Enable command, 158
[MC#] clip label, 159
nesting sequences, 158
switching, 158–159
switching among, 159

muting audio tracks, 245

N

nested clips, editing, 303
nested sequences, using, 300–302. See 

also sequences
nesting clips, 302–303
newspaper, nesting video in, 300–302
NLE (nonlinear editor)

Adobe Premiere Pro CS5 as, 11
benefits, 11

No Device Control or Capture Device 
Offline message, 69

noise selections, reducing in 
Soundbooth, 259

noisy audio, cleaning up, 256–259
normal.mov clip, playing, 329, 331
NTSC, pixel display for, 37

O

offline clips, making, 315
OMF (Open Media Format) export 

option, using, 356
OnLocation CS5. See also cameras

analyzing video, 328–330
changing Calibration workspace, 

323
described, 14
mini-workflow, 15
recording features, 327
setting up, 322–324
synchronizing matching shots, 333
using to analyze color, 331
Waveform Monitor, 328–330

Opacity effect, using in compositing, 
275–277

Open Project window, accessing, 16
ordering clips in sequences, 81
Out and In points, setting for clips, 71

Out point
keyboard shortcuts, 91
setting in Source Monitor, 88

Overlap option, using with clips, 81
overlay edit, performing in Source 

Monitor, 91
Overlay option, using with clips in 

Timeline, 86, 88

P

P2 format
CONTENTS folder, 53
essence in CONTENTS folder, 53
folder structure, 53–54
importing, 53–54
mono audio files, 54
using in tapeless workflow, 46–47

Paint Bucket coloring effect, described, 
293

PAL, pixel display for, 37
Panasonic P2 video format. See P2 

format
panels

moving, 20
opening, 21

panning and zooming, 64
parabola, creating for clips, 190
Parametric EQ effect, features of, 245
partitioning drives, 28
path, defining for text, 125–127
Path Type tool, using with text, 

125–127
path/velocity dots, displaying in 

Program Monitor, 190
Pen Keyframe tool, pointer changing 

to, 83
Pen tool, described, 94
performance, optimizing, 3
period (.) keyboard shortcut, using, 91
photo montage, applying transitions 

to, 110
Photoshop CS5 Extended

described, 14
mini-workflow, 15

Photoshop files
creating lower third, 340
importing as sequences, 33, 

339–342
re-creating lower-third animation, 

341–342
Photoshop layers, using blend modes 

with, 341
pictures. See shots
PIP (picture-in-picture) effect. See also

Motion effects
adding Bevel Edges Thin effect to, 

198–199
adding borders to, 197–199
adding drop shadow to, 199
creating, 196–197
creating 25% Center preset, 196
playing clips as, 148
replacing with footage, 149
screen locations, 196
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PitchShifter audio effect, using, 242
pixels, square versus rectangular, 37
Player Settings, choosing, 31
Play-Stop Toggle button, unavailability 

of, 38
pointer, changing to Pen Keyframe 

tool, 83
Poster Frame button, clicking, 39
preferences

adjusting for users, 30–31
Appearance category, 31
Audio category, 31
Audio Hardware category, 31
Auto Save category, 31
Capture category, 31
Default scale to frame size, 31, 36
Device Control category, 31
explained, 26
General category, 31
Label Colors category, 31
Media category, 31
Memory category, 31
navigating categories of, 30–31
Player Settings category, 31
versus sequence settings, 30
Titler category, 31
Trim category, 31

presets
choosing scaling for, 194
creating for video effects, 180–181, 

194
saving for other projects, 199

preview area, viewing videos in, 80
product home page, consulting, 5
Production Premium, features of, 

338–339
Program Monitor

displaying JPEG clip in, 36
Export Frame button, 358
Extract button, 146–147
Lift button, 146–147
path/velocity dots in, 190
performing ripple delete, 147
undoing edits, 147

project assets. See assets
project bin, arranging in Icon view, 80
Project Manager

Calculate option, 317
Collect Files and Copy to New 

Location, 317
determining file sizes, 317
features of, 13, 312
options, 316
saving projects, 316
trimmed projects, 317
using, 316

Project menu options
Export Batch List, 313
Import Batch List, 313–314
Link Media dialog, 314
overview of, 312–313
Project Manager, 312

Project panel
customizing columns in, 35
displaying icons in, 38

displaying thumbnails in, 38–39
expanding, 38
explained, 18
placing in frame, 21
viewing information in, 34

project settings
explained, 26
General tab sections, 27
saving presets for, 30
Scratch Disks tab, 28
selecting by sequence, 26
specifying, 27–31

projects
importing, 318
starting and opening, 16

.prproj extension, explained, 16

R

RAM, reserving amounts of, 31
Ramp coloring effect, described, 293
rasterization, process of, 34
Rate Stretch tool

changing speed with, 208
described, 94

Razor tool, described, 94
Rectangular Marquee tool, using in 

Soundbooth, 259
Redo command, keyboard shortcut 

for, 304
Reference Monitor panel menu, using 

with colors, 299
Replace Clip feature

undoing, 149
using, 148

Replace Footage feature, using, 149
resizing frames, 20
resources, consulting, 4–5
Reverb audio effect

applying to submix, 252–253
using, 242–243

reverse motion
Complete sequence option, 212
using time remapping with, 

211–212
RGB (Red, Green, Blue) effect, using, 

296–297
RGB Color Corrector coloring effect, 

described, 293
ripple delete, undoing, 150
Ripple Edit tool

described, 93
using, 85–87, 92
using with transitions, 100

ripple edits, explained, 142
Rolling Credits title, naming, 132
rolling edit, behavior of, 92
Rolling Edit tool

described, 93–94
using with A/B feature, 108
using with J-cuts, 234
using with L-cuts, 235

rolling edits
explained, 143
making, 144

rolling text, using in Titler, 132–133
rotation, adding to clips, 193–194
Rotation keyframes, adding, 174
Rotation value, changing for keyframes, 

175
rough cut, building from storyboard, 

78–82
rule of thirds, applying, 61–62

S

safe margins, turning off in Titler, 124
Saturation parameter, changing in color 

wheel, 299
Save command, keyboard shortcut for, 

304
saving preferences, setting, 31
scene detection, using, 73–74
Scratch Disks tab, sections of, 28
screen locations

coordinate system for, 188
for PIP effects, 196

script-to-screen workflow, explained, 
10

SD clip, comparing size to XDCAM 
EX, 55

Search box, clearing search criteria 
from, 41

Selection tool, described, 93
semicolon (;), use with video frame 

timecode, 222
sequence settings

choosing presets, 29
customizing, 29–30
explained, 26
versus preferences, 30
selecting, 26
tracks, 30

sequences. See also nested sequences
adding transitions to, 103
adjusting keyframes on, 94
automating storyboards to, 80
creating for storyboards, 80
defined, 17
detecting faces in, 270
finding gaps in, 11
fitting on screen, 82
importing, 318
importing Photoshop files as, 33, 

339–342
moving to beginning of, 307
moving to end of, 307
nesting for multiple cameras, 158
ordering clips in, 81
rendering portions of, 103
scrolling, 94
shooting, 63

settings, types of, 26
shadow text effects, using, 137
shapes

aligning, 130–131
creating, 127–129

sheen text effects, using, 134–137
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shooting video. See also video
applying rule of thirds, 61–62
avoiding fast pans, 64
avoiding jump cuts, 64
avoiding snap zooms, 64
considering amount of, 61
cutaways, 64
finding unusual angles, 63
following action, 62
getting close shots, 61
getting establishing shots, 61
getting natural sound, 65
getting sequences, 63
getting tight shots, 63
getting wide shots, 63
grabbing sound bites, 65
keeping shots steady, 62
leaning backward, 63
leaning forward, 63
matching action, 63
tips for, 60
using lights, 65
using trucking shots, 62

shoots, planning, 66
shortcuts. See keyboard shortcuts
shot list, recording video to, 327–328
shot placeholder, timestamping, 332
shots

keeping steady, 62
retaking, 328

Show Split View check box, using with 
colors, 298–299

shutter speed, adjusting for cameras, 
325

SiteCatalyst NetAverages, features of, 7
slide edits

explained, 143
making, 145

Slide tool
described, 94
using with A/B feature, 108

slip edits
explained, 143
making, 145–146

Slip tool, described, 94
Snap feature

frame-specific editing with, 84
toggling, 307

Solo buttons, using in Audio Mixer, 250
songs, mixing, 248–250
Sonoma recording, using Reverb for 

submixes, 251
Sony XDCAM video format. See

XDCAM format
sound. See audio
sound bites, grabbing, 65
Soundbooth CS5

adding audio effects in, 260
availability of, 256
cleaning up noisy audio, 256–259
described, 14
displaying frequencies over time, 

257
mini-workflow, 15
reducing noise selections, 259

Render and Replace command, 256
Settings link, 260
using Rectangular Marquee tool, 

259
viewing audio files in, 257
zooming in, 258

soundtracks
creating in Soundbooth, 256–259
fixing in Soundbooth, 256–259
sweetening in Soundbooth, 

256–259
Source Monitor

changing zoom level for audio, 223
creating subclips from, 154
displaying audio samples in, 222
displaying waveforms in, 221
dragging clips from, 156
editing tools, 90–91
performing overlay edit in, 91
placing clips in, 18
playing audio in, 222
trimming clips in, 89
using to add clips to Timeline, 

88–89
viewing clips in, 80
viewing stereo signal in, 223

spatial interpolation, defined, 194
speaker icons, using with mono effects, 

241
speaker tags, tagging text with, 265
specular highlight, viewing, 201. See 

also lighting effects
speech, transcribing to text, 264–266
speech analysis

enhancing accuracy of, 267
setting In and Out points for, 

268–269
speech transcription, batch-processing, 

266
speed changes, undoing, 213–214
speed keyframes. See also keyframes

creating transitions, 211
manipulating, 211
setting, 210

speed of clips. See also clips
changing in Timeline, 206–207
changing simultaneously, 213–214
changing with Rate Stretch tool, 208
downstream effects of, 212–213
varying via keyframes, 209–210

speed transitions, applying with time 
remapping, 211

split-screen effect, creating, 286
stereo effects, using, 244–247. See also

audio effects; mono effects
stereo signal, viewing in Source 

Monitor, 223
still images

changing length simultaneously, 214
importing, 32–33
marquee-selecting, 214

Storyboard bin
making active window, 79
naming, 79

storyboards
arranging, 80
automating to sequences, 80–82
using to build rough cut, 78–82

streams, determining in Export Settings 
dialog, 360

stroke text effects, using, 136–137
subclips, creating from Source Monitor, 

154. See also clips
submix tracks

applying Reverb to, 252–253
assigning audio tracks to, 220
outputting audio tracks to, 251–253

superimposed text, using, 116
surround sound clip, channels in, 

224–225
surround sound effects, using, 244–247
Sync Lock feature, using, 150
system recommendations, 3

T

tabs, displaying, 21
tape, recording to, 356–358
Tape export option, using, 355
tapeless media formats, support for, 11
tapeless workflows

availability of, 10
AVCHD recording format, 48
overview of, 46
P2 video format, 46–47
XDCAM format, 47

temporal interpolation, defined, 194
text

building from scratch, 121–125
crawling, 132–133
deleting in Titler, 123, 125
positioning, 122
putting on path, 125–127
rolling, 132–133
selecting in Titler, 118
transcribing speech to, 264–266
using Convert Anchor Point tool 

with, 126
using instead of voice-overs, 116

text effects. See also Titler
experimenting with, 137
fills, 135–136
shadows, 137
sheens, 135–137
strokes, 136–137

text parameters, changing, 117–120
thumbnails, displaying in Project panel, 

38–39
time changes, downstream effects of, 

212–213
time remapping

applying with speed transitions, 211
enabling time changes with, 

209–210
using with reverse motion, 211–212

Timecode area, changing in/out time 
in, 71
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Timeline
adding Encore chapter markers 

to, 378
applying keyframe interpolation 

in, 228
assembling clips onto, 90–91
Bypass option, 229
changing speed of clips in, 212–213
dragging clips to, 156
editing clips on, 82–86
expanding, 100
expanding for rolling edits, 144
finding gaps in, 151–152
getting into Encore, 377
Keyframes option, 229
Level option, 229
location and features of, 17
moving clips from, 86–89
moving clips to, 86–89
moving clips within, 86–89
moving current-time indicator to 

beginning of, 101
rendering, 55
resizing, 306
scaling, 35
scrubbing with current-time 

indicator, 87–88
sending trimmed clips to, 91
slowing down clips on, 206–207
speeding up clips on, 207–208
zooming, 214
zooming in and out of, 82
zooming into, 35

Tint coloring effect, described, 293
Title export option, using, 355
Titler. See also text effects

aligning shapes, 130–131
aligning text, 117
Area Type tool, 124
building and viewing graphics, 117
building and viewing text, 117
building text from scratch, 121–125
changing color-stop color, 136
changing video frames, 122
checkerboard pattern, 122
closing, 120
Color Picker, 136
crawling text, 132–133
defining text boundaries, 117
deleting text, 123, 125
Font Browser, 118
gradients for compositing, 276–277
Horizontal Center Distribute tool, 

131
interface, 117
loading titles to, 120
moving bounding boxes, 123
opening, 117, 307
opening New Title dialog, 121
paragraph text approach, 121
Path Type tool, 125–127
point text approach, 121
rolling text, 132–133
selecting text, 118
setting kerning, 119

setting leading, 118
setting preferences, 31
styles, 117–118
styles versus templates, 134
Templates screen, 134
text on a path approach, 121
transparency, 122
turning off safe margins, 124
Type tool, 122
using Eyedropper tool to select 

color, 136
using Small Caps, 118
Vertical Center Align tool, 131
Vertical text tools, 125
Word Wrap feature, 123

titles
exporting, 120
fading up, 120
in lower third, 340
moving, 120
switching between, 121–125
using, 116
using in projects, 120

Toggle animation button, using with 
effects, 171, 174

toolbar, docking, 100
Tools panel

editing tools, 93–94
features of, 19

Track Lock feature, using, 150–151
Track Matte Key effect, using, 284–285, 

287–288
Track Select tool, described, 93
track targeting, using, 156
tracks

finding gaps in, 11
location and features of, 17–18
placing transitions on, 102

transcribed text, copying to clipboard, 
269

transcribing speech to text, 264–267
transcription

modifying metadata in, 269–270
searching for keywords, 268

Transform effect, versus Motion effect, 
200–202

transitions
adding to audio clips, 111
adding to sequences, 103
applying between clips, 99–103
applying to audio clips, 229–230
applying to multiple clips, 110
applying to photo montage, 110
batching, 110
changing border color for, 105
changing characteristics of, 

104–106
changing default and duration, 101
changing duration of, 104, 108
dragging current-time indicator 

through, 109
fine-tuning via A/B mode, 106–109
improving visibility of, 100
keyboard shortcuts, 101
lengthening, 109

managing head and tail handles, 
109

number of, 99
placing, 101
placing on tracks, 102
single- versus double-sided, 101
types of, 98
uses of, 99
using to add visual interest, 99
using with restraint, 98

Treble audio effect, using, 242
trial version, obtaining for Adobe 

Premiere Pro CS5, 2
Trim Monitor

editing tools, 92
opening, 92

Trim panel, adjusting clips in, 92–93
Trim preferences, setting, 31
trimmed projects

Make Offline option, 317
using, 317

trimming clips, 82–85, 93–94
trucking shots, using, 62
TV sets, pixel display for, 37
Type tool, using with Titler, 122

U

UL screen location, using with PIP 
effect, 196

Ultra Key effect, using, 281–282
Undoing actions, 84, 304
updates, checking for, 6
UR screen location, using with PIP 

effect, 196
user preferences, adjusting, 30–31

V

VCR-style device controls, using with 
DV tape, 69

Vectorscope
displaying, 299
using to analyze color, 330

velocity, controlling on sides of 
parabolas, 190

Velocity graph, using with video effects, 
175

Vertical Center Align tool, using, 131
Vertical text tools, using in Titler, 125
video. See also analog video; clips; live 

video; shooting video
analyzing with OnLocation, 

328–330
capturing, 66–67
dragging in Source Monitor, 88–89
DV/HDV-capturing scenarios, 67
frames per second, 220
importing, 32–33
nesting in newspaper, 300–302
recording to shot list, 327–328
shooting with compositing in mind, 

275
viewing in preview area, 80
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Video and Audio settings, explained, 27
video and audio, unlinking, 307
video cameras. See cameras
video capture process, speeding up, 70
video cards, accessing list of, 3
video clips. See assets; clips
video effects

adding, 164
applying, 169
applying to multiple clips, 169
changing Count parameter, 171–172
combining, 173
creating custom presets, 180–181
creating presets, 173
Effect Controls panel, 164
features of, 164
finding, 167
fixed and standard, 164
ordering, 173
sampling, 165–169
saving as presets, 194
selecting, 180
Toggle animation button, 171, 174
toggling on and off, 166
using filters with, 180
using graphic-file alpha channels 

with, 279–280
Video Limiter coloring effect, 

described, 294
Video Rendering and Playback settings, 

explained, 27
video resource, consulting Adobe TV, 5
video tracks, clips in, 247
video transitions. See transitions
Video Transitions folder, using with 

nested clips, 303
voice, using Formant Preserve option 

with, 242
voice-overs

preparing for, 219
recording, 253–254
using headsets with, 219
using text instead of, 116

voice-recording area, setting up, 219

Volume effect, using with keyframe 
adjustments, 228

volume levels. See also audio volume; 
Channel Volume feature

adjusting with Audio Mixer, 247
identifying in waveform, 221
switching back to, 229

VST (Virtual Studio Technology) plug-
ins, using, 243, 246

VU (volume unit) meter, monitoring in 
Audio Mixer, 249

W

warnings. See error messages
watch folders, creating in Media 

Encoder, 362
Wave Warp effect

applying, 168
menus for, 168
resetting, 169

Waveform Monitor
displaying, 299
using, 328–330

waveforms
immutable quality of, 225
volume levels, 221

web-DVDs, search interface, 11
white balance, adjusting for cameras, 

326
White Balance color chip, using, 298
white card, accessing, 326
Windows, export formats, 359
Windows keyboard shortcuts. See

keyboard shortcuts
Windows Media format, using, 367
Wipe transition, applying, 105
work area bar, setting end points for, 

307
workflows. See also digital video 

workflow; editing workflow
accelerating with Adobe CS Live, 7
assembling clips onto Timeline, 

90–91

workspaces
Audio Mixer, 18
customizing, 20–22
Effect Controls panel, 19
Effects panel, 18
features of, 15–16
History panel, 19
Info panel, 19
layout, 17–19
Media Browser, 18
monitor views, 18
monitors, 18
Project panel, 18
resetting, 22, 35
saving customizations of, 22
timeline, 17
Tools panel, 19
tracks, 17

X

XDCAM EX high-definition clips
adding to Timeline, 55–56
comparing size to SD clip, 55

XDCAM format
use of, 46
using in tapeless workflow, 47

XDCAM media
importing, 50–52
rendering clips, 52

XMP (Extensible Metadata Platform), 
explained, 268

XMP metadata, explained, 264

Z

zoom levels, returning to, 306
Zoom tool, described, 94
zooming and panning, 64
zooming in

and out of Timeline, 82, 214
Soundbooth, 258
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